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=T — R EHRIET D ERARETT,

Vo2, PCB7 eV MTIMABNEZT—F =2« V7 « 77 AL Z@ LT, BEK= R
=R b e NRFG AR AR T — X R AW THSLENE T, 2D 7 7 A /L% MS-Access 35 L Of
MS-SQL server ## DO FHTERY AR — F L FEk. U713 ODBC £z K> THRESNE T,
RAN—=VDIE, DXP T MS Access 7— X N— A LR A R—F > b EORD, T—H—

A YT e Ty ANEERLOERSNEZY V7 OfERLEST, ZOFa2—hITATE, V>
JF DT —H_X—R|ZB LT, \Program Files\Altium\Examples\4 Port Serial
Interface 7ANFIZHDHY U TNV EFHIT, bV IrREDX kY b Ty T IhD
OPEFHLTCWET, Zotrrrray= ME, BIEX =z R —3%> b3 \Program
Files\Altium\Examples\Cis 7 A /VZRNIZHDH T/ T 7 A /L MS Access T — X X—R + 7
7 A )V Example database.mdb 2V 27 LTWET,
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E(;  database ; Database {Access fi = MS Access database
i open bf Desion glew W fp *mdl file
Ohbjects ] CreatetableinD apacito ble m][E
Create table by u Part Mumben | Manufactuer P/|  Manufactuer Description Package =
s V] createtable by of ) \ ECK-D3D101KE Panasonic - EC CAP 100PF 2K Radial
Caparitors codioot ECK-D30102KE Panasonic - EC CAP 1000FF 2| Radial
s Corectors cof1o02 BCK-D3D121KE Parasonic - EC CAP 120PF 2K Radial
B Reports Disgletes cor1003 | E}K-D3D122KE Panasonic - EC CAP 1200PF 21 Radial
) Foges i codi004 EQW-03D151KE Panasonic - EC CAP 150PF 2K Radial
i - codi00s ECK-D30152KE Panasonic - EC CAP 1500PF 2| Radial
T Macros el coi1006 ECK\D3D181KE Parasonic - EC CAP 160PF 2K Radial
@& Moduls e codioo? ECK-D3D182KE Panasonic - EC CAP 1800FF 21 Radial
Trpnsistors T - i 7
codi008 ECK-03D221KE Panasonic - EC CAP 220PF 2K Radial =
Groups Record] 14 r“*””lfi""'»’i"»* el R »F‘

DXP Schematic Editor

Component Properties %1 7 1 7 D/ A —%

xample D atabasze DPLINK * ] \\
| Enable || . " R
— == | Databbse key field:  |Part Humb | Use the Database Links document to connect the figlds in your database to the parameter names in A
v | Hatabpss key e A0 umeer - your design project. One key pair must be designated for matching, and the others may be left 3
Connectors v | Part ki w parameter.  |Part Number | inactive, set to default update aptions [Chrl + D], or individually set with update behavior. :
[T Discretes v | D . —
fHics v -
[T Resistors v 5 L e it |=
[ Swiches . e it e A ety Rt (el Rt b el o e
[T Transisters Ad Cog103 2222 370 2268, BC Components  CAP .OBBUF 1000 METAL FILM BOX  Radial Bulk (.068pF
37 Z 2104 |BC ents |CAP . 1UF 100v METAL FILM BOX,
Co0103: 2222 #7012154 BC Components  CAP . 15UF 63% METAL FILM BOX Radial Bulk (0.16pF
can1033 2222(370 12224 BC Components  CAP . 22UF B3 METAL FILM BOX Radial Bulk 0.22pF
/
] i [ e
\ Databasq Lifks A Table Browser
Database Link file (*.DbLink) /|
(/
Farameters fpf C12| CAP 2M < 3 s -
; ,9 CAP .1UF 100V METAL FILM BOX
Yigible Mame Walue , Type .
¥|  Capactance 0 STRING Cl2
¥ Description e AUF 100v{METAL FILM BOX STRING | 0. TuF
v ranufactuer ,éC Companent STRING 0.05
v Manufactuer P/ ,/ 2222 370 21 w STRING 100V
v PatNumber 7 CODTO37 SHRHHE P C001037
Test Fieldt CAPACITOR STRING BC Components
v Tolerance 005 STRING 222237022104
v Yaltage-Fated 100 STRING

NI A—=REFRLEEKX 2 o R—F3 b

EARERE  R T A, YT 7 P 2 4 Port Serial Interface DAIBSX] = K — 5 MICY 2 L THOETS,

F—RAR—Z D7 ILDOEFE

DXP OF — X R_— 2L, T 7 4Lk TiE MS Access 7 — % X—A(*.mdb 7 7 A V) HICRE S

TWETRN, ODBCHEH THNIEED L H T —F_XR—ATHLT 7 RATHZENTEET, T

Yo, JOBRELARET, T —FX—2 L LTExcel 77 A V(Xs)a EBEHTEET, 7—4

NR—2 L LTExcel 77 A NVEFEHTHZ LICEALTOFMIE, ZOF 22— b T ATRIZHTT S
lExcel RK¥ =AU 7| OEEZBRLTLIEEND,
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1. MSAccess #fEI LT, 2R —3 MEREFATNAET —FX—R « 757 AL (*mdb) Z/E
L ET., MSAccess THEDT —TNEHATLT7—4 =20ty b « T v 7 HiEZ
\Program Files\Altium\Examples\Cis\Example database.mdb #ZZ|ZL T &V,

Microsoft Access

Elle Edit ¥iew Insert Format PRecords Tools  Window Help

E-HH gLy s=2@ 2l il ZE T M e B B,
. Example database : Database (Access 2000 file for... |- |0 @

[ open [of Design ghew R 2

Objects

&

[EC SN EE Capacitors : Table

%‘ Createtable by ol | Pan Number |Manufactuer P/ Manufactuer | Description Package =

Queries || 2 Crestetable by e b | GERTIEN ECK-D3D101KE Panasonic - EC GAP 100PF 21 Radial

Capacitors | |conom ECK-DAD02KI Panasonic - EC/ CAP 1000FF 2| Radial
TR Connectors | |cootonz ECK-D3D121KI Panasanic - EC CAP 120PF 2K Radial
B Reports Discretes | |cooioo3 ECK-D3D122KI Panasonic - EC CAP 1200PF 2| Radial
%) Pages s | |coo1o04 ECK-D3D1571KI Panasonic - EC CAP 150PF 2K Radial

Aot | |cootoos ECK-D3D152KI Panasonic - EC/ CAP 1500FF 2| Radial
2 Macros s | |cootoos ECK-DAD1ATKI Panasonic - EC CAP 1A0PF 2K Radial
& Moddes i | |cooioo7 ECK-D3ID182KI Panasonic - EC CAP 1800FF 2| Radial

| |cooioos ECK-DD221KI Panasanic - EC CAP 220PF 2K Radial ||
Groups Record: _I4 I N ] Kin|

Datasheet Wiew 4

2. THHNRT —H X=X « Ty A L TEMRICHESNLTNDZ L &R LT IZZW, BT
FAMIUITHFAN ANV UT o RTGRA—F—=REHIND LR ETT, T—HX—R 7
7 AN (*.mdl)&E—7 L TMSAccess ## T LET,

3. DXP %Zi# LT, \Program Files\Altium\Examples\4 Port Serial Interface 7 #*
NEIZHDHPCB7aY=”7 b 4 Port Serial Interface.PrjPCB A4 —7> L, Yuv=x
7 NORIFER R Ay hEREET,

T—BR=R-Y2D-T74 L DIERK

T—H XA T AT SN TWETH, DXPOFTT—HR—R - J 7 - 75 AL

(*DbLink) % 1ERT 5 MBS B 0 £9., F—F~X—2 + U > 7 (DbLink) 7 7 A MIERLE K3 2 A > k

FitRESNTa R =R MOV v BIOT 4 RXR—RZERTLEOICERASET, 2

DT 7ANNEY b« To7INTHEEE, BIEX EOa R R—xr ML, Vo7 LeRIFA—%

—DHEFICE D T —F_R=2ANEOFERCTHFTL N TEET,

4 Port Serial Interface 7 V=7 NHOT—ZX—2 « Y7 « 77 AL, BRICFEELTWHETHR

FIAAER T B HEE R LET, b LBIOINET —F_X—R 27 m Y=y MR T 555100, #

Tl T —B_X—=R s Yy « T A )VEFRETIHLENRDY 77,

1. PCB7uv=x/ MIT—FRX—R U7 « 77 A)VEMZDHITIL, Projects "Fx D70 =
7~ 44 4 Port Serial Interface.PrjiPCB %7 U » 7 L THEIR L TH2H, A ==a2—205 File » New »
Database Link File #34R L £,
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1 Design Explorer DXP - Database Links1.DbLink

BIox Ele Yew Froject Toos Window Hep [ 5 @ @ S |20 ML DGR
Projects B [ 4 Port Serial Interface SchDoc | 5 =
@
ProjectGroup1. PiGip Table Enable Database key field:  [<Choose Fieldy | Use the Database Links document to ~ 2
" connect the fields in pour database ta the —
| 4 Port Serial Interface. PRIPCE - | Patt key parameter; |<Choose Parameters | patameler names in your design project,
65 Drefault Fabrication Outputs. Outl ~
= Database Links Files
Example Datsbaze DELIMK [8)
E base Links1.DbLink (3]
= &3 PCB Libraries =
# 4 Port Serial Interface. PebLib (1C v
Files e \ Database Links / Table Browser /
X:140%:560 Gnd10 Files | Libraries | Messages  Mavigate | Projects | Browser | Panels. Help

2. {ERESN/=H L7 7 A /b Database Linksl.DbLink N7 WA 2« 74> RUIZERIIN,
Projects /Xr /L H1® Database Links Files %7 7 + LV Z1ZU A F EvE T,

T—AR—REHRDIETE

T—=BNX—=R e Yy s Ty AARBIMENAUL, T—FX—A~DEROIREEZIT) ZENTEE
T, ELTEDT —HRX—R + 74— )L RN, EOTHA L IINTGA—F—L—HTHUNERNH LD,
FLEEFNED LT IFA KR LR TUER S RO EOEEITY ZENAEEE D £7,
1. Tuvxl MITF—H_X—R&2FHT5I121E, A ==2—»5 Tools » Database Connection %
BRL, RF-LE
Connection tab of Database

Database Connection

C)OHneCtiOflff /rf "7 AT Source of Connection
AFEY, HERET -2 v O Use Data Link File

Uo7 e Anudl), E01E | |
ST —H_R—R « T 7 AL
(il 21 *mdb)iz U > 7 & 45
Edpaxrsyar e AR
v OFRRICE - THITAE
T BT NOT =2 R—2 [ ok ][ cencel |
DY TX, C¥RTATh
LM NAZIBE L TVD Z EITEE LT ZE8W, LEREAIL, Database Connection 5
AT TCInNbEERELET,

2. ZOFa—hMUTATIE Access 7 —HFN—R « T7 A N~DOPEGEA M) T ERFERLET,
Use Connection String #3#{RL Build R ¥ > %27 Vv I §25&, 7= V22w TaNr AT
nyNFERENET, T MK - ZTHNO OLEDB 7Y u A XU A K Ti, Microsoft Jet 4.0
OLE DB Provider 35 7 4/ h TREIN TV ET,

(&) Usze Connection Sting
I-.-1"-.E:-:.arr| lezhCighE vample databaze. mdb;Persist S ecurity |Info=F alze | ’ Build... ]
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B2 Data Link Properties

T=RYYY FanTa &
A7BRTTF F—FfEA

Provider | Connection |Advanced Al

Specify the following to connect to Access data: L j“;t-\g VEHY)YHTE
1. Select or enter a databaze name: & . Microsoft DXP Tl&# <)
St a ' DANILTHRFSNET,
2. Enter information to log on to the database: Microsoft's ADO Provider
User name: |Admin | Properties and Settings @

ELITELVMESRIFY VY -
http://msdn.microsoft.
com/library/default.as

p?url=/library/en-

us/dnacc2k/html/adopro
perties.asp.

[ ok [ cancel |[ Hep | ESBLTCESL,

Blank password [ &llow zaving pazsword

wies 7 in, 77y xRe dr s v o s s LRV F— s xR TR £
Fe B R—Z2ADT 7 A N, 5z 1T C:\Program Files\Altium\Examples\Cis\Example
database.mdb 2R L, BKORZ 227V v 7 LET,
TR R ANOERPRI L 2 & 2RI 272010, [
DTFAMM) A2 %7 )y 7 LTS, HRen il nid, & | \13) Test connection succasded.
ATRITTRRENET, TRXTOXATRINPHALLND ET,

K U kYA
Bisnhi-s—4~_X—X - J 7 « 774 /L(*DbLink)i%, Table
Browser 15 & (" Database Links % 7 C7 —# BN /RINE T,

Microsoft Data Link E|

Table Enable
'fﬁﬁﬁf;ﬁé Table 73§/f Z\V—j/l/bz fJTOTU‘%) Z k %ﬁ%gﬁg\ l/—( < fié l/\o Bim Capacitors v
s R . N S [Tl Connectors v
T A=A YT - Ty A VO Table Browser % 7 Tl 7 Fpiseretes v
—HN—R T =TNEZRTDIENTEET, NEDEIET, fics v
e S = N - - < Resistors v
ST — 5 S—ATITH LERDY £ T, 22 THBROABTEE 0
ZITHO ZEIETEERE A,
[ atabaze Links1.DbLink *
Table | Enable | | ) - i elds i
: ——= =" | Database kev field: <Chooss Fisld> + | Use the Databaze Links documnent to connect the figlds in your ~
acitars v | —! database to the parameter names in your design project. One key
[ Connectors v | Part key parameter:  <Choose Parameter>  w | pair must be designated for matching, and the others may be left =
[T Discretes v | -~ i
fics v —a
[T Resistars v =IE 0l |=
ﬁ Switches v Manufactuer F/H anufactuer Drescription
[T Transistors v ECK-D3D101KBP

cootom ECE-D3D102KEBP  Panasonic -

cooooz2 ECK-D3D121KBP  Panasonic - ECG CAP 120PF 2KV CERAMIC DISCYSP  Radial Bulk
Co01003 ECK-D3D122KBP  Panasonic - ECG CAP 1200PF 2KV CERAMIC DISCYSP Radial Bulk v
< | 3

_\ Database Links ), Table Browser /
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Database Links # 71347 —7 N DF—F_X—Z « 7 4 —)L K&, THA L5 A —%— L
fIH10IERENET, T—F =2« U7 OREICHETIHEMI. ZOFa2—M) T
D [ F—=EX=R 20 FTo32DRTE] DEAEBRLTLIZEN,

53] Database Links1.DbLink " |

Enable

Databsse key field  [<Chonse Fields +| Use the Database Links document to connect the fields in pour »~
Cl v database to the parameter names in pour design project. One key
[ onnectors v Part key p ter:  [¢Choose P. ter>  w | pair must be designated for matching, and the others may be left
ﬁ Dizcretes v
v . % 2 e
% lFES st v [atabase Field... Design Parameter | Update Values Add To Design Vizgible On A...| Remove From De... |
esistars
ﬁ Switches v @
ﬁ Trangistors v &

Y Datahase Links fTable Browser /

F—ID4—ILRELUF— - INSA—E3—DERTE

B ONRTG A= =% T —=ZN—=2 + T 7 A JLOFERITHS S HT0IE, T—F_R—Z -
>« 7 7AW X T Database Key Field % Part Key Parameter & — ﬁté’@f:?o< M%b)a‘o nET,
¥—7 ¢ —)L NIZ@H, "—VEHEZOLIRT —FX—2AFDa R - N EBEFICHET S
OOLOTT, FEE, TPEREINEERER R —FR 2 b ff#é%ﬁéntPMKw
Parameter 4 & #t & iA A, RIZT —HX—R « 77 A )VFOIRESNILT —FRX—R « F—T 1 — )b
RERBELT, TNOR—BLTHGE, 74 X—2AFDOEDO L a— Lo /E, BIEK =R
=R MOy TENTNT A—H—ITEINET,

F—T 4NV RIE, BT T VHOT —H X=X VT T A LTRESNTHNET, 1D

2T —H_X=2OHF T, B S—=YNET =TT~y F X

HHEDIHEHAENDEF—7 4 —/ K& LT, 1o0 Database | Database key field: | Part Number v

Key Field X ' 1 DDBEFED TV A /35 X — % —(Part Key Part key parameter. |Part Number -

Parameter)Z18E L CTH L LENH Y 7, b L7 Part Key

Parameter B 1F/E L72WEATE. ZTREER L TBMLERH Y 9, I 52 554X,  Parameter

Manager % fi > T Part Key Parameter D1Eff] DHAZML T EZSV, F—T7 1 —/L P& F— -

NI A= =53 I DHITIE

1. Database key field © K12 v 75 %2 U 2 fp 55— 4 R R TRON ST 0 T LM R L
TLEEW, 70 4 Port Serial Interface 71 2= 7 hTlid, 7 —#~<—Z® Part Number
74—V R, BIEXK = R—3%> h® Part Number /87 A — % —{Zxba LTV ET,

2. Partkey parameter ® Ku v 77X 7 U A RnL, PCB7r Y7 FORKK K¥a A2 N TOD
RGRA—B—ZFBN | F—ER_R=Z VoV« Ty A Nt —T LET,

Parameter Manager % f o T® Part Key Parameter D{ER{;
Parameter Manager #fEf7 % &, BT 5 a0 R —1 2 MIHTZ72  pommmmm——

NRIA—=F—%BMTHZENTEET, 7D 4 Port Serial O
Interface [EIFE X D& = > 7R — % > MZIE Part Number /X5 A — & — BlPot [ HosPormies S ] Erne bl
FEECEME N COETOT, 208y v a VOBREFT B8EixHy | -7 O 0T e
E VR o
[] Eschude System Purameters [ Seloched Dbincts Only
6
Co o)
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Parameter Manager Z#ffifl L T, $L\WWRT A —F —ZBINT 51203

1.

T AR R 2 A v M EBWEZRIKBX T « # T, A==2—7»5 Tools » Parameter
Manager Zi®#R L £,

B OFT X TONN—VNIH 2728 T A — X —%5BI19 5121%, Parameter Editor Options % A
7 1 7 @ Include Parameters Owned By =7 + = >/ Parts 3% L, Criteria (% All
Objects # 4R L OK %27 U v 7§ 5% & Parameter Table Editor ¥ 4 7 v 7 3 F RSN ET,

Parameter Table Editor For Project [4 Port Serial Interface.PRIPCB]

User Parameters o]
ame Library Reference| Capacitance | Manufactuer Manufactuer P/M | Part Number TextFieldl | Tolerance |Voltage-Rated | Power| Resi..|C.. F.. L.|P.. V.. P..| New parameter +
CAP 20 50pF Kemet C1206C510GGAL COO18E2 CAPACITOR 0.05 = +
DIODE General Semiconc TNA004 #001005 14 400 +
DIODE General Semiconc 1M4004 001005 14 40C +
CON ATEZB EDAC Inc. 395-062-520-350 JOOM027 +
CRYSTAL ECS Inc. EC5-18-131 %001003 1.8 13 +
CAP 20 01pF BC Components 2222 370 22104 COOM037 CAPACITOR 0.05 100y H
CAP 2M 01pF BC Components 2222 370 22104 CO01037 CAPACITOR 0.08 100 +
CAP 2M 01pF BC Components 2222 370 22104  CO01037 CAPACITOR 0.05 100 +
CAP 2M 01pF BC Components 2222 370 22104 CO01037 CAPACITOR 0.05 1004 all
£ |
#ccept Changes [Ciealz ECO) | [ Cancel |

Add Column %= 7 U v 7 32 & Add Parameter ¥ A4 7 v 7 I3 R
INFEF, HLWWIT A —F—4% AJjL Add to all objects % 7
Vw27 L¥ET, Value DEREITIAETYT, OKZ 27 U v 7 LT
é I/\O

Engineering Change Order % A 7 v 7 % &R I & 5 72912 Accept
Changes (Create ECO) "% > %7 U v 7 LET,

Add|Parameter;

Name: | New parameter |

Engineering Change Order:

Modifications Status ~

Enable Action Affected Object Affected Docurment Check. Done =
Add Parameter(39]
W Add E] New parameter= to C1 In 2 4 Port UART and Line Drivers SchDoc &
W Add E] Mew parameter= to C2 In 2 4 Port UART and Line Drivers SchDoc &
W Add E] Mew parameter= to C3 In 2 4 Port UART and Line Drivers SchDoc &
W Add E] Mew parameter= to C4 In 2 4 Port UART and Line Drivers SchDoc &
W Add E] Mew parameter= to C5 In 2 4 Port UART and Line Drivers SchDoc & a
- = Y . s e P s bt

[ Walidate Changes I I Execute Changeﬁlﬁeport Changes.. ]

EHENG % R L C Validate Changes 27 U v 7 L9, fER15E 794U (Status Lo 7
v/ ~v—27%R"LTCWET) | Execute Changes #7 U » 7 LT,

HHNKETLEGClose 227 Vw7 LET, UETHLWAT A—FZ—0EERTOa R —>F
Y MIBMERTWET, ZA6DOEFRROMRNL, FHM RFa A hpTarR—xr b
X7 Nr Y 7 LT Component Properties A 7 2 7 KR L TUTAET, HLWWITA—X
—7% Parameters U A2 MIEMENTWET,

T—ER=R- VY- FTFav DRE

BB B T 8 N A OBEEDEIE S, % (b K2R Ay — B SIS, 7
BR=A D HENET —H =R« U7 « 77 A LD Database Links ¥ 7 OHTEN L&~ v ¥
YIFHILITED | BIEKICERT D I LR TEET,
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T4 T—=ER—=R Yo - AT a3V DERE

EEE R 2 A v Mt L, NT A= =B, BH, BlBROT 74V K -T2 a VERETD

TERTEFET, Bl T X—RIERDHLHEICDIR, AR =R MIRT A—F— %4

WIMATZWGE, RIA—=F—2 T T 20HIBRT 2N ERINT L2208 TEET, ZhHDT 7

a > 1%, Update from Database =~ FZETTHBECEITINE T, TRHOT 740 ME, T—

HBR_R—=R e Y7 « 77 A NVHOEMIRA VAL VAT HZ LN TEET,

1. T7F)b A7V arEty b9 5I2i%, Tools » Options Z3&IRT 570, BV ETHEZ Y v
27 LT, Options %395 & Database Link Options ¥ A 7 0 7 NFRENET,

Database Link Options

Drefault &ctions
Update Values | Update Vl
Add To Design | Add only if nat blank in database v |
Remawe Fram Design | Do naot remave A |
[ oK ] [ Cancel ]

2. HET—F_X—=2AHOIET DT 4 — N FinbOfE#FF > 7o, BEFADREEK = R —x 2 b
DRT A== EHTDGRCEASNDET 7 4VDT 7 a v a#ELET, Ray 74y
VVARNPST AN bOA T a v EBRLET,

3. ZOXATaTTERINDIEREIL, T—F~X—RX - U7« 757 A/LHO Update Values,
Add To Design <> Remove From Design 7 7 2 C Default 25ER I TV b DI SN E
To T—HN—ANHNATA=F =% THTLHEIUT. 60T 74V MREEMEHT 20,
H 2 1ZEH, BN, HIBROBRENTED L IR THET, OKEZ Vv 7 LTT—HX—R -
Vo7« 774 MIRY £7,

T—RAR—=ZYUHDER

EEE = R—3 2 NEEHTHRATONDT 74/ N - T v a VBEEINELIZOT, T—
HRX—=R e YU « T7A)NTT—HX—=R « Y7 EERTDILENRDH Y 77,

F—H =R+ Yy - 77 A /LD Database Links ¥ 7NTT — X _X—Z « U 7 RS BT
1. 4T& A 74 & Ctri+D 2L £,

T YA H® Design Parameter BERK XL, T —F N—R « 7 ¢ —)L R4 LR AR THT B
%7, Database Link Options ¥ A4 7 1 7 CREINIZ, T 74NV NEHFOF T a vy (F7 41
B) 1T _RTA =T M5 TWET,

N
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] Ewample Datsbase DBLINK

Table Emjble Database key field.  |Part Number ~| Usethe Databa_se Links chum_Ent to connect the fields in yuur_dalabase to the parameter names in ~
your design project. One key pair must be designated for matching. and the others may be left
Connectors v Part key parameter  |Part Murnber ~ | inactive, set to default update options [Chl + D], or individually set with update behavior. 2
ﬁ Dizcretes v
v
il D atabase Field Mame Diesign Parameter Update alues Add To Design “Yigible OnAdd | Remove From Design ~
[T Resist v
Esistars Capacitance Capacitance Drefault Default Drefault
ﬁ Switches v
ﬁ Transistors v £ Description [Mone]
£ Features [Mane]
# Manufactuer Manufactuer Default Default Detault
& Manutactuer PN Manufactuer PAN Diefault Default Diefault
w

% Mawimum Temperature [Hone]

' Database Links A Table Browser [

3. THNR—R T4 )V RE BARANRTA—2—8 BEFEPEH) 12V 7 SEDLGEAIE.
Design Parameter £ % 7 U v 7 LTIER L, BOZ Vv 7 LTIAT T U E T YR RPbHTL
WRT A= — 55D, BAWVITESEAN L TRELET,

4, 1 B EBYIRL, BRERTRTOT—HRXR—=R « VoI HBERLET, HOF =7 ~—713,
T—HR—=R « T g =)V RB{ETFA L« RTZA—F =D/ T VIV BHELTND I EEZRL
TVWET,

TRENDINFGA—F—BEHFA T avDEE

T =B R=ANHDONRT A—=2—lBEEHTLHEI. ZNENDT 4 —/NV T, 774/ MNREE

N9 HZ &b TExE 9, Update Values, Add To Design <> Remove From Design % 7 L5077 7 +

v EEET HITIE

1. WETLH74— NV a7V 7 LGERLET, OV Y v 735 L RABERIN, Fry
O R NBFIHARTHLZEERLET,

Database Field .. Design Parameter | Update Walues Add To Design | Misible On ... | Remowe From D1 | #
#: Capacitance Capacitance Drefault Default Drefault
# Manufactuer b anufactuer Default D efaul - Default

% Manufactuer PAM Manufactuer P/N- Default Default D efault
2% Mawirmum Tempera [None] Do not add
4% Package [Mone] Add anly if nat blank in databas w

" Database Links /4 Table Browser [

2. FIANINEREDICLTWVWTF—HRN—Z - 74— L RO Ry FE T Y R NS LERT
IvavEBERLET, BIRLET 7V aviid—4_"—X - U7 « 774 VDR TEHRFRIN
F, T—HRX=2 YT - Ty A NEE—-TLET,

Engineering Change Order (ECO)Z MM LT, 7 —Z X—ZAnbEEK K¥ 2 X v M2 EHT 5586,

EHI XA NOUEREFRZRAT L TEET,

F—AR—Z SO EREOEH

MERBRENT N CTER S N7 5, Update from Database =t~ > K% {#ifl L T Engineering
Change Order Z{Epk L TREDEH TV E7,
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FIRSE R 2 A > MZED, A ==—»5 Tools » Update from Database #3i#IR L, T —# X
—2ADRT A =L —f L FHIFH &£, Update from Database % 4 7 0 ZNFmREN, ZDF
AT TEHFLIEVEEK Ry Ay hBIRa L R—3 b« XA TEBIRTEET,

Update From Database

Schematic Sheets Component Types A
Schematic Sheet Library Reference Library Count

2 [ 4 Port Serial Interface. SchDoc Tr [¥] CAPZM . 2

=] 4 Poit UART and Line Drivers.SchDoc T CON ATEZE 1

B (v 154 Bus and Address Decoding. SchDoc e DIODE 2 —
g ELECTRO RE 1
L ELECTRO1 2
g F22y10 1 v

EHTHREE RFa A hBXRayRm—3x bk« XA TEBERL (Fzvr<w—7% AN
%), BHOHMEREL TCOHLO0KEZZ Y v 7 LET, ST — X =R L 3= L OGN
BEN., WIZHEH INDHEER —>Y DY R 3 Select Parameter Changes % A 7 1 7 TR

Rty

ShET,

Select Parameter Changes

2 Objects - 1 Selected Spstem Parame... | User Parameters
Object Type Document Identifier Description Capacitance  |Manufactuer | Manufactuer P/N | Package Tolerance Voltage-Rated
> Part Yo BC Components 2222 370 22104 Radial * 005 ooy
{0 Part o TpF BC Components 2222 370 22104 Radial Yoos oo
I Update All l I Reject All l Show all parts [ Accept Changes (Create ECO] ] [ Cancel l

ZOXAT a7 TR, EHEANCT D0, HDVERNT D03% /87 A—F —BL TRETE
F9, Update Al 22 UV v 7350, HOAWEEFH LI-WAT V=7 MEFEBRIRLET, Zh
3. RIRA—Z—=NT = ZRXR=ANLEH SNLEED A be— LD E 52 F3, KRIT,
Accept Changes (Create ECO)% 7 U v 7 9% & | Engineering Change Order % A 7 1 7' 33K 7R
IhET,

Engineering Change Order

Status

Modifications
Enable Action Affected Object Affected Document Check. Dane

Add Parameter(1]
v Add [E] Package=Radial to C11
Change Parameter Yalue(1]

v Modify E] C12:Package [ > Radial] In & 154 Bus and Address Decoding SchDac

I Walidate Changes l [ Execute Changes[}}[ﬁepolt Changes... ]

Validate Changes 27 U » 7 LC, Status ’OK Th 2 (F=v I/ ~v—I RN TnET) Z &
ZEB LT 72X, Execute Changes 27 1V v 7§25 LT A —F =B ET, FITMN
SET3hUE, Close 27 U v 27 LET,

Bl L CHIEEH 2 R =R bORT A= —[FTEHFINET, INHOEHHRIT,
Parameter Manager % 9 7>, List /X% /LD H T IsParameter 27 = U T 20, H B
FIEK KX a2 A hoaryiR—3xr N ETHET V7Y v o LTERIND Component Properties
FATR I T THIENTEET,

[& 154 Bus and Addiess Decoding.SchDoc




FmFNR—ZPS TR f DY D

Excel FFaARED) D

T —H R AL T 7 4V N TliE Access T —H X—Z(*.mdb 7 7 A WAIZEY R Ty TEINT

WETH, V=R« FT—F =L LTExcel 77 A NMBEATEZZ L L TEET,

BEfFD Excel F¥ =2 AV FEEIRKEK Ky = A MY 7351203

1. File » New » Database Link File 23R LT, PCB7r Y =/ MIT—FX—RA - J 7 7
7 A /L (*.DbLink)Z B L £ 97,

2. Tools » Database Connection Z 3 L £, Use Connection String % &R L T Build %2 U
v ITHE, T—=H V7 TuRT 4 XTI RNERERET,

3. FunAF - ZT%7 Y 7 L, Microsoft Jet 4.0 NEIR SN TWAHZ L xR LET, ZhiT
Access T —HN—2 « T A JVHEHENDH LT —FRX—=R - YT « T7 A )VDI=ODT
T4V MRETT,

B3 Data Link Properties

Prawvider |Cnnnection Advanced | Al

Select the data pou want to connect to:

OLE DB Provider(s)

MediaCatalogDB OLE DE Provider
tediaCataloghdergedDB OLE DB Pravider
tediaCatalogw/ebDE OLE DB Provider

Microzoft 154K 1.1 OLE DB Provider

Microzoft Jet 3.51 OLE DB Provider

Micr =t 4.0 OLE DB Provider

ticrozoft OLE DB Provider For Data Mining Services

[ Ok H Cancel ][ Help ]

4, §RT X 7%V v 27 LTLE &, Extended Properties 7 4 —/L K& & 712V w7 LT, 7

O/NNFrDEFHEZ AT 0 7 OTAINTLDIET 4 —/L FIZ Excel 8.0 AL, OKZZ U v 7

LET,
& Data Link P
Provider | Connection | Advanced | Al |
These are the inlialization propeties for this type of data, To edita
value. select a propeity. then chooss Edit Yalue below
Name Value ~
Data Source CPROGRAM FILESVALTIL
Extended Properties
Jet OLEDE:Compact With.. False
Jet OLEDB:Create System... False
Je OLEDB Detabass Loc.. 1
Fioperty Description
|Extended Properties ]
Fioperty Value
[Excelfidl |
[ ok J[ cancel |[ Hep |
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5. Eﬁ&f%ﬁuy7Lffi?7%%&y[]%#LUMwsihﬂxfxm§Wﬁ47mfﬁ%
Excel(xls)7 7 A VAR L £, I7ANDFEE D% TRTDITPAILEH) 42, BRIO
Excel 7 7 A VEHEL T 5 O0pens 27V v 7 LET,

BHEOTAMRZ %2 ) v 7 LET, BEREAEITIUIHERO A v —VURERSNET,
T—H R« YT« Ty A NE, ENTETNDOT—T7 )L LT Excel v — FDT —T7 )V EFIR
LTWET, BEART—TUNA X —T Mo TNDI EEHER LTSN, 77— - %
— AT RAREE@)BEMS N THETN, T Excel D FPRIGETY 7 LTfEICEEL £
/Vo

8. ¥—T 44—V KREEBYNNLT I ary A4S araWH LT, HEEY—AL LT Access 7 —
B R—R e LR ERIBROGIET, L7 —% V7% (Crl+D #fEH L) 1EkL
TLIEE,

9. T—HR—R- YT Ty NEEY T yTINEL, £FLTH DL Design » Update
from Database ##iR L CECO #3T L7, HEESNTRIKEX F¥ = A > hoBmRs ==
VR—=FR R e RNTG A= L T R=ANLEHINTWVET,

BOM A R D=7/ NS5 A—2—DFEFH

LT A= —B X ORFOMPT VA o ~BiAEni=72 5, Report Manager % fifi i L T L
WarR—x 2 MERZEY A AT Bill of Materials Z /B35 Z LN TEXET, RDOAXT v 7Tl
COERREIEZER LT LET, Excel 77 L— R A LT, BOMF—% 235 L 145
ZLICBELTOMEMT., ML A= OI AL~ A X Fa— I TAESRLTIIEEN,

1. Excel BOMT7 7 b—hk « 77 A4 )T, LI T 24, Bl Column=Part Number %/l
ZTCLTEEN, LT 7 L— b (Bl z21E BOM Default Templatel.xlt) % \Program
Files\Altium\Templates 7+ /VHIRFL, T L—b - 77 A VEHALCET,

2. DXP T Reports » Bill of Materials % 3R L T, Report Manager (¥ /L1 BOM %43 2
HAIZIL  Bill of Materials (By Part Type) for Project [Project name.PRJPCB]# A 7 10 )& R &
HTLTEENY,

Bill of Materials (By PartType] For Project [4 Port Serial Interface PRIPCE]

Grouped Columns Show | | Comment + || Description = | Designator ~ | Foatprint - || LibRef ~ || Quantity |~ || Part Mumber | A
Comment ¥ 0WF Capacitor 0.2 pich  C1, C2, L3, 4, L5, RAD02 CAF 2 10 COG1037 ]
20pF Capacitor 0.2 pitch  £13 RADD.2 CAP 2M 1 COD1861
50pF Capacitor 0.2 pich  C14 RADD.2 CAP 2M 1 CO01862
10uF Electrolytic Capacito C15, C16, C17 TANT 24/2M ELECTRO1, ELECT 3 Coo1G18
1N4004 D1,D2 DIODED.4 DIODE 2 001005
Other Columrns Show |~ pR3z Nl DRATRAF DR37 1.J001ng
Pad-r(mm) CON ATE2E P1 ECN-BMXT COMN ATE2E 1.Jo01027
Part Field 1 M A1 A4IAL0.4 RES1 1 RO02014
Part Number v K5 R2 AXIAL0.4 RES1 1 RODI737
PartType % 10K RESISTOR METWE RP1 sIPe RESPACK BCOMML 1 RODIZT7F
Ei’;f'ca":a‘h BASE ADDRESS 51 DIP1E SwDIP2 1 5001163
. ~| |INTERUPT SELECI 52 DIPg 5w DIP-4 15001175 ©
Template  BOM Default Template?. st jE] Relative [ Repart.. ] [ Expart... ] [ Excel... ] [ oK ] I Cancel }
Batch Mode CSY [Comma Delimited) [7.csv] j Open Exported [ Farce Columns Into Yiew

3. BT L4, BIzIEF AT a7 N Other Columns 7 ¥ 2 > H1® Part Number 7 Show 7R
TRV I THZELELY, LR—FOHFTEREETZND T ARRINTE ET,

12



FmFNR—ZPS TR f DY D

75 ?X‘E]ﬂfﬁ’ VEMLTH LW T L— b, BIZIE BOM Default Templatel.xlt &
R2oF, Template 7 4 —/V R TT7 7 A VA ZRRIE T 0pen 27 Vv 7 LET,
BRSNS Excel A7 Ly K =27 L Ea—7F57202, Excel "% %2710 v 7 LET,
BOM ([ZIZBMME N T8 LA T A(Part Numben) b DF —Z BNER RSN TV ET,

Open Exported (ZF = v 7 ~—7 % AL, MS Excel TDXP BOM O# L\ Excel A7 L v K -
= FEBRLIEDICOKEZ 2 U v 7 LET,

E3 Microsoft Excel

Eile Edit Wew Insert Format Tools Data  MWindow Help P r he
DEESs SGRAY $BR-<F 9o-c- @ = -4 %] (1w -3, sl B
El1 5 f Part Mumber
=h 4 Port Serial Interface.xls
A B
1
Bill of Materials |BvPartType ForProject [4 Port Serial Interface. PRJPCB]

2

3 Source Data From: 4 Port Serial Interface.PRJPCB

4 Project: 4 Port Serial Interface.PRJPCB

5 |Variant: None

6

7 |Creation Date: 9/04/2003 11:59:41

¥ 14

& Print Date:  9/04/2003 12:15:57

)

10

14 |Footprint Comment LibRef Designator Part Number ‘ﬂ-‘ [Quantity

12 |[RADD.2 0.1uF CAP 2M C1,C2 C3,C4,C6, €3, C9, C10, C11, €12 |CO0M037 10
13 |[RADD.2 20pF CAP 2M C13 CO01861 1
14 \RADD 2 S0pF CAP 21 C14 Ccoonee2 1
15 TANT 2M/2M [10uF ELECTRO1, EUC15, C16, C17 CO0ME13 3
16 DIODED.4 TN4004 DICDE D1, 02 »¥001005 7
17 DB37RA/F  |DB37 DB37 1 001009 1
AR ECALIPMYT  lenn ATEIR oM ATRIA, (B nN1A97 1
M 4 » ¥ \BOMReport{ Project Information / I“ L
Ready
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